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Tutorial Hack Registry Windows 

Berikut ini adalah tips registry windows, sebelum Anda merubah registry windows 
pastikan bahwa Anda memback-up nya terlebih dahulu. Seandainya perubahan 
tersebut mengakibatkan error, Anda masih bisa mengembalikannya seperti semula. 
Menyembunyikan drive pada My Computer 
Ikutilah langkah berikut. Klik Start*Run, ketikkan regedit lalu tekan Enter. Anda bisa 
menyembunyikan drive pada My Computer dengan cara masuk ke :Key 
:HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor
er 

Value Name : NoDrives 

Data Type : REG_DWORD 

Data : 

Pada data bisa Anda isi dengan drive yang ingin Anda sembunyikan. Adapun nilainya 

adalah : 

A: 1, B: 2, C: 4, D: 8, E: 16, F: 32, G: 64, H: 128, I: 256, J: 512, K: 1024, L: 2048, M: 

4096, N: 8192,  

O: 16384, P: 32768, Q: 65536, R: 131072, S: 262144, T: 524288, U: 1048576, V: 

2097152, W: 4194304,  

X: 8388608, Y: 16777216, Z: 33554432, ALL: 67108863 

 

Menyembunyikan icon Network Neighborhood 

Icon Network Neigborhood akan nampak pada desktop jika Anda menginstall Windows 

Networking. Jika Anda tidak suka, Anda bisa menyembunyikan icon tersebut. Ikutilah 

langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: HKEY_CURRENT_USER\Software\Microsoft\Windows 

\CurrentVersion\Policies\Explorer 

Value Name: NoNetHood 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled/menyembunyikan icon) 

 

Mendisable MS-DOS Command Prompt 

Setting berikut ini akan mencegah "penggunaan" MS-DOS command prompt pada 

Windows. 

Ikutilah langkah berikut. 

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: HKEY_CURRENT_USER\Software\Microsoft\Windows 

\CurrentVersion\Policies\WinOldApp 

Value Name: Disabled 

Data Type: REG_DWORD Data: (0 = disable, 1 = enable/mencegah MSDos command 

prompt) 
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Mencegah penggantian setting Display Properties 

Anda dapat melakukan Setting display dari Control Panel - Display atau melalui klik 

kanan pada desktop, lalu pilih Properties. 

Dengan setting di bawah ini orang lain tidak dapat mengganti setting pada Display 

tersebut. 

Ikutilah langkah berikut. Klik Start * Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Syste

m 

Value Name: NoDispCPL 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled/mencegah penggantian) 

(Membuat key System : Pada panel sebelah kiri, pilih Policies, klik kanan, New - Key. 

Beri nama System. Lalu pilih System, klik kanan, New - DWORD Value. Beri nama 

NoDispCPL. Klik dua kali pada NoDispCPL, 

ganti angka 0 menjadi 1 untuk mencegah penggantian setting Display Properties. 

 

Menyimpan isi folder 

Anda yang sering mengamati isi dari suatu folder, tentunya butuh cara yang tepat dan 

cepat. Untuk itu ikuti langkah berikut : 

Pertama buat file isifolder.bat dengan Notepad dan diletakkan di c:\windows, lalu 

ketikkan :  

@echo off  

dir %1% /o > c:\windows\isifolder.txt 

notepad c:\windows\isifolder.txt 

Buka registry lalu ke key [HKEY_CLASSES_ROOT\Directory\Shell 

Buat key baru dg mengklik kanan pilih New - Key. 

Pindah ke panel sebelah kanan, klik 2x pada Default. 

Isi dengan & Lihat Isi Folder 

Buat key lagi dengan nama command. 

Pada panel sebelah kanan klik 2x pd Default. 

Isi dengan c:\windows\isifolder.bat %1 

Mulai sekarang untuk melihat dan menyimpan isi dari suatu folder, Anda tinggal 

mengklik kanan pada folder tersebut. 

 

 



Tips Trick, Software Reviews, Download Gratis  
http://memikatcahaya.com 

________________________________________ 
* Tutorial ini boleh disebarluaskan untuk kepentingan pengetahuan dan bertukar informasi (tidak untuk 
komersial), dengan tetap mencantumkan sumbernya yaitu http://memikatcahaya.com 

Mencegah perubahan setting Network 

Jika Anda meng-enable setting ini, maka orang lain tidak dapat mengganti setting pada 

Control Panel - Network. 

Ikutilah langkah berikut. Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Networ

k 

Value Name: NoNetSetup 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled) 

(Bila belum terdapat key Network, cara membuatnya sama seperti tips setting Display 

di atas) 

 

Mencegah perubahan setting Printer 

Jika Anda meng-enable setting ini, maka orang lain tidak dapat mengganti setting pada 

Control Panel - Printer. 

Ikutilah langkah berikut. Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name: NoPrinters 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled) 

 

Mencegah perubahan setting Password 

Jika Anda meng-enable setting ini, maka orang lain tidak dapat mengganti setting pada 

Control Panel - Password. Dengan kata lain orang lain tidak dapat mengganti 

password (jika komputer Anda memakai password Windows). 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Syste

m 

Value Name: NoSecCPL 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled) 
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Mencegah perintah Shut Down 

Setting berikut akan mencegah seseorang untuk mematikan komputer Anda. Hal ini 

berguna jika misalnya Anda meninggalkan komputer untuk beberapa saat dan Anda 

khawatir ada orang lain yang akan men-Shut Down komputer Anda. Ikutilah langkah 

berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name: NoClose 

Data Type : REG_DWORD 

Data: (0 = shutdown enabled, 1 = shutdown disabled) 

 

Menyembunyikan semua item pada desktop 

Setting berikut akan menyembunyikan semua item yang terdapat pada desktop Anda. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key : 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersionPolicies\Explore

r 

Value Name : NoDesktop 

Data Type : REG_DWORD 

Data : (0 = disabled, 1 = enabled) 

 

Disable klik kanan pada Dekstop & Windows Explorer 

Jika Anda meng-enable setting di bawah ini maka tidak ada yang bisa melakukan klik 

kanan pada Desktop & Windows Explorer. Dengan kata lain menu yang muncul waktu 

klik kanan tidak ada lagi. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: HKEY_CURRENT_USER\Software\Microsoft\Windows\ 

CurrentVersion\Policies\Explorer 

Value Name: NoViewContextMenu 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled) 

Untuk melihat perubahannya Anda perlu melakukan restart. 
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Disable klik kanan pada Taskbar 

Jika Anda meng-enable setting di bawah ini maka tidak akan muncul menu waktu 

melakukan klik kanan pada Start Menu, Tab control, dan Clock. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er] 

Value Name: NoTrayContextMenu 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled) 

Untuk melihat perubahannya Anda perlu melakukan restart. 

 

Mengganti alignment/perataan teks pada Drop Down Menu 

(drop down menu = menu yg muncul saat Anda mengklik menu File, Edit, Help, dll pd 

berbagai aplikasi Windows) 

Secara default, alignment pada drop down menu adalah rata kiri. Kalau Anda suka, 

Anda bisa menggantinya menjadi rata kanan. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Caranya : 

Key: HKEY_CURRENT_USER\Control Panel\Desktop 

Value Name: MenuDropAlignment 

Data Type: REG_SZ 

Data: (0 = rata kiri, 1 = rata kanan) 

Langkah terakhir sebelum melihat harilnya adalah restart. 

 

Menghilangkan panah pada shortcut 

Kalau kita membuat shortcut dari suatu aplikasi atau pun directory pasti akan kita lihat 

sebuah panah kecil. Dari segi penampilan, panah yang menutupi sebagian icon 

tersebut sangat menjengkelkan. Apalagi jika kita ingin menonjolkan gambar icon 

tersebut. Untuk itu ada sebuah cara untuk menghapus panah tersebut sehingga 

penampilan icon kita lebih 

menarik. Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. Hhapus string value "IsShortcut" yang 

ada di dalam subkey "lnkfile" dan 

"piffile" pada key "HKEY_CLASSES_ROOT" dari registry windows Anda. 
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Install font dengan lebih cepat 

Untuk menginstall font biasanya kita harus mengikuti langkah yang panjang : Start > 

Settings > Control Panel > Font. Lalu dari situ Anda harus klik File > Install New Fonts. 

Cara tersebut tentunya sangat menjengkelkan. Sebenarnya ada cara yang lebih 

mudah, yaitu : 

Cara pertama : 

1. Buka registry editor. 

2. Pindah ke key "HKEY_CLASSES_ROOT\TTFFILE\SHELL". 

3. Pilihlah perintah "Edit > New > Key" dan berikanlah nama "Install Fonts" pada key 

yang baru diletakkan tadi. 

4. Klik ganda pada bagian jendela kanan pada entry "(Default)". 

5. Berikan nilai "Value"-nya "Install Font" dan konfirmasikan perubahan ini 

dengan mengklik "OK". 

6. Tandai sekali lagi subkey "Install Font" dan di dalamnya dengan menggunakan 

perintah "Edit > New > Key". 

7. Buatlah sebuah subkey baru yang dinamakan "command". 

8. Klik ganda pada "(Default)", berikan pada "Value"-nya perintah 

"c:\windows\command\xcopy32.exe %1 c:\windows\fonts". 

Sekarang jika Anda mengklik kanan pada file *.ttf akan muncul menu Install Fonts. Jika 

anda memilih menu ini, maka file font tersebut akan dicopy ke dalam folder Windows 

Anda. 

Cara kedua : 

1. Buat shortcut yang menunjuk ke directory font pada Windows Anda 

(C:\Windows\Fonts). 

2. Letakkan shortcut tersebut pada directory Send To. 

Sekarang untuk menginstall font, klik kanan pada file *.ttf, pilih Send To > Fonts. 

 

Menyembunyikan menu Start Menu > Settings > Taskbar 

Jika Anda meng-enable setting ini maka menu Taskbar yang terdapat pada Setting 

pada Start Menu akan hilang. 

Ikutilah langkah berikut. Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name: NoSetTaskbar 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled/sembunyikan) 
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Menyembunyikan menu Start Menu > Settings > Folder Options 

Jika Anda meng-enable setting ini maka menu Folder Options yang terdapat pada Start 

Menu - Setting akan hilang. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name: NoFolderOptions 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled/sembunyikan) 

 

Menyembunyikan menu Start Menu > Settings > Control Panel 

Jika Anda meng-enable setting ini maka menu Taskbar yang terdapat pada Setting 

pada Start Menu akan hilang. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name: NoControlPanel 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled/sembunyikan) 

 

Menyembunyikan menu Find pada Start Menu 

Jika Anda meng-enable setting berikut, maka Find yang terdapat pada Start Menu 

akan hilang. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name: NoFind 

Data Type: REG_DWORD 

Data: (0 = disabled, 1 = enabled) 
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Menyembunyikan menu Document pada Start Menu 

Setting berikut akan menyembunyikan folder atau menu Document yang terdapat pada 

Start Menu. 

Ikutilah langkah berikut. Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key : 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name : NoRecentDocsMenu 

Data Type : REG_DWORD 

Data: (0=disable, 1=enable) 

 

Menyembunyikan menu Run pada Start Menu 

Setting berikut akan menyembunyikan folder Document yang terdapat pada Start 

Menu. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key : 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name : NoRun 

Data Type : REG_DWORD 

Data: (0=disable, 1=enable) 

 

Menyembunyikan menu Help pada Start Menu 

Setting berikut akan menyembunyikan folder Document yang terdapat pada Start 

Menu. 

Ikutilah langkah berikut. Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key : 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name : NoSMHelp 

Data Type : REG_DWORD 

Data: (0=disable, 1=enable) 
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Menghilangkan Start Banner pada taskbar 

Jika Anda meng-enable setting ini maka panah dan tulisan Click here to start akan 

hilang (tulisan muncul pada saat masuk windows). 

Ikutilah langkah berikut. Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Key: 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explor

er 

Value Name: NoStartBanner 

Data Type: REG_BINARY 

Data: (00 00 00 00 = disabled, 01 00 00 00 = enabled) 

 

Menambah menu Explore From Here pada folder 

Setelah Anda mengganti dengan nilai di bawah ini maka saat Anda mengklik kanan 

pada folder akan muncul menu Explore From Here. Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Caranya : 

Pertama buka key : 

HKEY_CLASSES_ROOT\*\shell\rootexplore. 

(Anda harus membuatnya jika key tersebut belum ada) 

Lalu editlah nilai "(Default)" dengan "Explore From Here". Pada rootexplore buatlah 

sebuah key baru dan beri nama dengan command. 

Edit "(Default)" dan beri nilai/nama "explorer.exe /e,/root,/idlist,%i". 

 

Mengganti daftar program Add/Remove Programs 

Saat Anda menginstall program maka sebuah program (yang baik) tentunya akan 

menambahkan untuk Unsintall (pada Add/Remove Programs). Tapi bila Anda telah 

meng-uninstall program tersebut dan masih terdapat entry pada Add/Remove 

Programs Anda bisa menghilangkannya secara manual. Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Caranya masuk ke key : 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall 

Setelah itu Anda bisa menghapus entry yang masih tersisa.  

 

Daftar pada menu Run 

Kalau anda mengklik tombol Start-Run, maka akan terlihat sebuah kotak dialog Run. 

Pada kotak ini ada daftar cukup panjang berisikanperintah-perintah terakhir yang anda 

ketik dan jalankan, yang amat berguna untuk mempercepat pemanggilannya kembali. 

Daftar ini tersimpan di registry pada folder 

HKCU\Software\Microsoft\Windows\Current- Version\Explorer\RunMRU (MRU 

kependekan dari most recently used). 

jika penuh isinya, ada 26 perintah yang terlihat, dengan nomor urut berupa huruf abjad. 

Anda bisa menghapus satu atau beberapa perintah pada daftar di folder RunMRU, 

atau menyunting isinya. Boot ulang Windows 95 setelah melakukannya. 
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Mengganti nama Recycle Bin 

Microsoft memperkenankan Anda untuk mengganti nama My Computer dan Network 

Neighborhood, tetapi mengapa tidak untuk Recycle Bin? Kita bisa mengganti sendiri 

nama Recycle Bin dengan cara menyunting Registry. Untuk itu, ikutilah langkah 

berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. Masuklah ke entri 

HKEY_CLASSES_ROOT\CLSID\ {645FF040-5081-101B-9F08-00AA002F954E}\ 

ShellFolder 

Anda akan menemukan nilai Attribute dengan nilai biner 40 01 00 20. 

Klik gandalah icon Attribute pada panel sebelah kanan untuk menyunting nilai ini. 

Tekan Delete sekali, ketikkan 50, dan pilih OK. Nilai biner seharusnya menjadi 50 01 

00 20. 

Tutup Regedit dan kembalilah ke desktop Anda. Kini, jika Anda mengklik kanan 

Recycle Bin, Anda akan melihat perintah Rename. Anda juga bisa mengklik Recycle 

Bin dan menekan F2 untuk mengganti namanya dengan nama yang Anda inginkan. 

 

Mengganti daftar add /remove programs 

Saat Anda menginstall program maka sebuah program (yang baik) tentunya akan 

menambahkan untuk Unsintall (pada Add/Remove Programs). Tapi bila Anda telah 

meng-uninstall program tersebut dan masih terdapat entry pada Add/Remove 

Programs Anda bisa menghilangkannya secara manual. 

Ikutilah langkah berikut.  

Klik Start*Run, ketikkan regedit lalu tekan Enter. 

Caranya masuk ke key : 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall 

Setelah itu Anda bisa menghapus entry yang masih tersisa. 

 

Memproteksi Sistem 

Kotak dialog log in Windows dimana kotak tersebut tampil pada layar dan menanyakan 

nama pemakai berikut passwordnya. Jika diisi dengan nama pemakai yang tidak 

dikenalnya, Windows akan mengijinkan user tersebut masuk. Jika seseorang tidak 

memberikan informasi apa pun, ia cukup menekan tombol Escape. Windows 9x 

memang tidak dirancang untuk menjadi sistem operasi yang aman, tetapi bukankah 

akan menjadi lebih baik jika ada cara sederhana untuk menjamin bahwa hanya 

kombinasi nama dan password user tertentu yang bisa melewati kotak log in tersebut? 

Suntinglah Registry dan Anda akan bisa mengatur siapa saja yang bisa log in ke 

komputer Anda. Namun, sebelum melakukannya, ikuti langkah setup ini. 

Pertama-tama, Anda harus mengaktifkan profil user dalam komputer Anda. Pilih 

Start*Settings* Control Panel, klik dua kali pilihan password, dan klik tab User Profiles. 

Pilih opsi "Users can customize theirpreferences and desktop settings". Juga berikan 

tanda cek di samping kedua pilihan di bawahnya. Pilih OK. 

Kini buatlah account untuk Anda sendiri. Dari Control Panel, klik dua kali User dan 

gunakan wizard untuk menambahkan sebuah profil untuk Anda sendiri. Jika tidak ada 

icon Users dalam Control Panel Anda, berarti Anda sedang menjalankan versi asli 

Windows 95, dan harus menjalankan langkah berikut: Pilih Start*Shut Down, pilih 

"Close all programs and log 
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on as a different user", dan klik OK. Saat kotak dialog log in muncul, masukkan nama 

user dan password baru. Ketikkan password kembali saat Windows meminta 

konfirmasi. 

Kini Anda siap menyunting Registry. Mulailah dengan menjelajahi key berikut: 

HKEY_USERS\.Default\Software\Microsoft\Windows\Current\Version\Run. Dengan 

folder Run tetap terpilih, pilih 

Edit*New*String Value. Ketikkan GoAway dan tekan Enter untuk memberi nama value 

tersebut. Kini klik dua kali GoAway dan ketikkan rundll.exe 

user.exe, EXITWINDOWS. Klik OK. Kini Anda bisa menutup RegEdit.  

Saat berikut kotak dialog log in Windows muncul, Anda bisa melakukan log in dengan 

nama user dan password yang Anda berikan untuk Anda sendiri. Jika seseorang 

menekan tombol Escape atau memasukkan nama user dan password baru, Windows 

akan menolaknya dan segera melakukan log out untuk kemudian menampilkan kotak 

dialog log in kembali. 

 

Menambah Jumlah Recycle Bin  

Anda bisa membuat destop Windows 95 nampak unik dengan memperbanyak jumlah 

icon keranjang sampah ( Recycle Bin ) di dalamnya. Bila perlu letakkan keranjang 

sampah tersebut di setiap sudut layar monitor, sehingga bila suatu saat ingin 

menghapus suatu file, dengan musah anda bisa menyeretnya dari explorer ke 

keranjang sampah terdekat. Demikian pula sebaliknya jika anda ingin mengambil 

kembali file yang sudah dihapus. 

Untuk menambah jumlah icon Recycle Bin, Mulailah dengan menjalankan regedit, lalu 

berpindahlah ke folder 

HKEY_CLASSES_ROOT\CLSID\{645FF040-5081-101B-9F08- 00AA002F954E}. 

Selain subfolder tersebut ke dalam Clippbord Windows 95, caranya dengan menarik 

menu Edit-Rename. Bisa juga dengan menekan tombol Ctrl-C (atau Ctrl-Ins). 

Sekarang klik kanan sembarang tempat pada dekstop Windows 95, lalu pilih New-

folder pada menu yang muncul. Berikan nama bagi folder tersebut, misalnya Keranjang 

Sampah di ikuti tanda titik. Di akhir nama, klik kanan lalu paste, sehingga secara 

keseluruhan nama folder tersebut menjadi Keranjang Sampah. {645FF040-5081-101B-

9F08- 00AA002F954E}. Selanjutnya tekan enter, maka secara otomatis icon folder 

tersebut berubah menjadi icon Recycle Bin. 

Ulangi langkah-langka ini untuk membuat sebanyak mungkin keranjang sampah yang 

anda inginkan ( tapi masing-masing harus memiliki nama berbeda), lalu letakkan di 

berbagai sudut dekstop. Bisa juga cukup anda klik kanan salinan keranjang sampah 

yang sudah Anda buat tersebut, lalu gunakan perintah copy dan paste untuk membuat 

salinannya. Selamat mencoba. (dari berbagai sumber) 


